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Load Test:

Load Tests are end to end performance tests under anticipated production load. The objective of such
tests are to determine the response times for various time critical transactions and business processes and
ensure that they are within documented expectations (or Service Level Agreements - SLAS). Load tests
also measures the capability of an application to function correctly under load, by measuring transaction
pass/fail/error rates.

Load Teds are mgjor tests, requiring substantial input from the business, so that anticipated activity can
be accurately simulated in a test environment. If the project has a pilot in production then logs from the
pilot can be used to generate ‘ usage profiles’ that can be used as part of the testing process, and can even
be used to ‘drive’ large portions of the Load Test.

Load testing must be executed on “today’s’” production size database, and optionally with a *projected”
database. If some database tables will be much larger in some months time, then Load testing should
also be conducted against a projected database. It is important that such tests are repeatable, and give
the same results for identical runs. They may need to be executed several times in the first year of wide
scale deployment, to ensure that new releases and changes in database size do not push response times
beyond prescribed SLAS.

What is the purpose of a Load Test?

The purpose of any load test should be clearly understood and documented. A load test usually fitsinto
one of the following categories:

Quantification of risk: Determine, through formal testing, the likelihood tha system performance
will meet the forma stated performance expectations of sakeholders, such as response time
requirements under given levels of load. This is a traditional Quality Assurance (QA) type test. Note
that load testing does not mitigate risk directly, but through identification and quantification of risk,
presents tuning opportunities and an impetus for remediation that will mitigate risk.

Determination of minimum configuration: Determine, through formal testing, the minimum
configuration that will alow the system to meet the formal stated performance expectations of
stakeholders - so that extraneous hardware, software and the associated cost of ownership can be
minimized. ThisisaBusiness Technology Optimization (BTO) type test.

Assessing release readiness by: Enabling you to predict or estimate the performance characteristics of
an application in production and evaluate whether or not to address performance concerns based on
those predictions. These predictions are also valuable to the stakeholders who make decisions about
whether an application is ready for release or capable of handling future growth, or whether it requires a
performance improvement/hardware upgrade prior to release.
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What functions or business processes should be load tested?

The most frequently used transactions have the potential
High frequency transactions to impact the performance of all of the other transactions
if they are not efficient.

The more important transactions that facilitate the core
objectives of the system should be included, as failure
under load of these transactions has, by definition, the
greatest impact.

At least one READ ONLY transaction should be included,
Read Transactions so that performance of such transactions can be
differentiated from other more complex transactions.

At least one update transaction should be included so that
Update Transactions performance of such transactions can be differentiated
from other transactions.

Mission Critical transactions

Load Testing Process

| dentify the performance-critical scenarios.
Identify the workload profile for distributing the entire load among the key scenarios.

| dentify the metrics that you want to collect in order to verify them against your
Performance objectives.

Design tests to simulate the load.
Use tools to implement the load according to the designed tests, and capture the metrics.
Analyze the metric data captured during the tedts.

Load Test Terminologies:

Scenarios are anticipated user paths that generaly incorporate multiple application
activities. Key scenarios are those for which you have specific performance goals, those
considered to be high-risk, those that are most commonly used, or those with a significant
performance impact. The basic steps for identifying key scenarios are.
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Metrics are measurements obtained by running performance tests as expressed on a
commonly understood scale. Some metrics commonly obtained through performance tests
include processor utilization over time and memory usage by load.

Responsetime is a measure of how responsive an application or subsystem is to a client
request.

Throughput is the number of units of work that can be handled per unit of time; for
instance, requests per second, calls per day, hits per second, reports per year, etc.

Workload is the simulus applied to a system, application, or component to simulate a usage
pattern, in regard to concurrency and/or data inputs. The workload includes the total number
of users, concurrent active users, data volumes, and transaction volumes, along with the
transaction mix. For performance modeling, you associate a workload with an individual
scenario.

Resour ce utilization is the cost of the project in terms of system resources. The primary
resources are processor, memory, disk 1/0, and network 1/O.

Scalability refers to an application’s ability to handle additional workload, without
adversely affecting performance, by adding resources such as processor, memory, and storage

capacity.

Perfor mance requirements are those criteria that are absolutely non-negotiable due to
contractual obligations, service level agreements (SLAS), or fixed business needs. Any
performance criterion that will not unquestionably lead to a decision to delay a release until
the criterion passes is not absolutely required and therefore, not a requirement.

Contents of performance-testing effort in project context:

Project vision: Before beginning performance testing, ensure that you
understand the current project vision. The project vison is the foundation for
determining what performance testing is necessary and valuable. Revisit the vision
regularly, asit has the potential to change as well.

Purpose of the system: Understand the purpose of the application or system you are
teting. This will help you identify the highest-priority performance
characteristics on which you should focus your testing. You will need to know the
sysem's intent, the actual hardware and software architecture deployed, and the
characteristics of the typical end user.

Customer or user expectations. Keep customer or user expectations in mind when
planning performance tesing. Remember that cusomer or user satisfaction
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is based on expectations, not simply compliance with explicitly stated
requirements.
Business drivers. Understand the business drivers — such as business needs or
opportunities — that are constrained to some degree by budget, schedule, and/or
resources. It is important to meet your business requirements on time and within the
available budget.

Reasons for testing performance: Understand the reasons for  conducting
performance testing very early in the project. Falling to do so might lead to
ineffective performance testing. These reasons often go beyond a list of
performance acceptance criteria and are bound to change or shift priority as the project
progresses, 0 revisit them regularly as you and your team learn more about the
application, its performance, and the customer or user.

Value that performance testing brings to the project: Understand the value that
performance testing is expected to bring to the project by trandating the project- and
business-level objectives into specific, identifiable, and manageable performance
testing activities. Coordinate and prioritize these activities to determine which
performance testing activities are likely to add value.

Project management and staffing: Understand the team’'s organization,
operation, and communication techniques in order to conduct performance testing
effectively.

Process: Understand your team’'s process and interpret how that process applies to
performance teging. If the team's process documentation does not address
performance testing directly, extrapolate the document to include performance testing
to the best of your ability, and then get the revised document approved by the project
manager and/or process engineer.

Compliance criteriaz  Understand the regulatory requirements related to your
project. Obtain compliance documents to ensure that you have the specific
language and context of any statement related to testing, as this information is critical
to determining compliance tests and ensuring a compliant product. Also understand that
the nature of performance testing makes it virtually impossible to follow the same
processes that have been developed for functional testing.

Project schedule: Be aware of the project start and end dates, the hardware and
environment availability dates, the flow of builds and releases, and any
checkpoints and milestones in the project schedule.
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Load Runner:
HP LoadRunner, atool for performance testing, stresses your entire application to isolate
and identify potential client, network, and server bottlenecks.

HP LoadRunner load tests your application by emulating an environment in which multiple
users work concurrently. While the application is under load, LoadRunner accurately
measures, monitors, and analyzes a system’ s performance and functionality.

How LoadRunner Addresses the Performance Testing:

LoadRunner reduces personnel requirements by replacing human users with virtual
usersor Vusers. These Vusers emulate the behavior of real users— operating real
applications.

Because numerous Vusers can run on a single computer, LoadRunner reduces the amount
of hardware required for testing.

The HP LoadRunner Controller allows you to easily and effectively control all the
Vusers—from a single point of control.

LoadRunner monitors the application performance online, enabling you to fine- tune
your system during test execution.

LoadRunner automatically records the performance of the application during atest. You
can choose from awide variety of graphs and reportsto view the performance data.
LoadRunner checks where performance delays occur: network or client delays, CPU
performance, |/O delays, database locking, or other issues at the database server.

L oadRunner monitors the network and server resourcesto help you improve
performance.

Because LoadRunner tests are fully automated, you can easily repeat them as often as
you need.

Various Components of LoadRunner:

Vuser Generator:

Vuser Generator is the Script generation component of LoadRunner. This component has two
main things and are described below:

Vusers: In the scenario, LoadRunner replaces human users with virtual users or Vusers. When
you run a scenario, Vusers emulate the actions of human users working with your application.
While a workstation accommodates only a single human user, many Vusers can run
concurrently on a single workgation. In fact, a scenario can contain tens, hundreds, or even
thousands of Vusers.

Vuser Scripts: The actions that a Vuser performs during the scenario are described in Vuser
script. When you run a scenario, each Vuser executes a Vuser script. The Vuser scripts include
functions that measure and record the performance of your application’s components.
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Controller: You use the HP LoadRunner Controller to manage and maintain your scenarios.
Using the Controller, you control all the Vusersin a scenario from a single workstation.

Load Generator: When you execute a scenario, the Controller distributes each Vuser in the
scenario to a load generator. The load generator is the machine that executes the Vuser script,
enabling the Vuser to emulate the actions of a human user.

Performance analysis. Vuser scripts include functions that measure and record system
performance during load-testing sessions. During a scenario run, you can monitor the network
and server resources. Following a scenario run, you can view performance analysis data in
reports and graphs.

Working with LoadRunner

When testing or monitoring an environment, you need to emulate the true behavior of userson
your system. HP testing tools emulate an environment in which users concurrently work on, or
access your system. To do this emulation, the human was replaced with avirtual user, or a
Vuser. The actions that a VVuser performs are described in aVVuser script. The primary tool for
creating Vuser scriptsisthe Virtual User Generator, VuGen.

Vusers emulate the actions of human users by performing typical business processes in your
application. The actionsthat a VVuser performs during the recording session are described in a
Vuser script.

Using VuGen, you can run scripts as sandalone tests. Running scripts from VuGen is

useful for debugging as it enables you to see how aVuser will behave and which enhancements
need to be made.

Stepsfor Creating Scripts:
VuGen enables you to record a variety of Vuser types, each suited to a particular load

testing environment or topology. When you open a new test, VuGen displays a complete list of
the supported protocols.
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Record a basic Vuser script

" el

Enhance/edit the Vuser
script

= L=
P

Configure Run-Time settings

Run the Yuser script in
stand-alone mode

-

o~

Integrate the Yuser Script

This window opens up as soon as you open the VuGen. Y ou can select the protocol of you
application and click ok. For most of the web application its Web (HTTP/HTML) Protocol

Open VuGen

To start VuGen, choose Start > Programs > <App_Name> (for example LoadRunner) >
Applications > Virtual User Generator from the Start menu.

To open an existing script, not in the recent list, click Open Existing Script.
To create anew script using arecent protocol, click the protocol inthe
Recently used protocolslist.

To create anew script in a protocol that is not listed, click New Vuser Script.

Choose File > Zip Operations > Import From Zip File ... to open an existing Script from a zip
archive.
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HP ¥irtual User Generator - [Start Page]’ |

: File Yew Tools ‘window Help

= - | B= - | [E] i @ startPecord B B 01 95 | e lab Gl EP i Tasks | |EE]Script &, Tres [ == 3]
Stark Page
EA Virtual User Generator P e ail

Scripts | Online Resources | What's Mew |

Iwl

Recenty used protocols

g web [(Click and Script)

ek (HTTRAHTMLY

MNew Yuser Scrpt...

[% Welcome to the Wirtual U

In a testing environment
physical machines with "
create load on a system
repeatable and predictat
transactions that enable
information to help you |

Recently used scripts

‘E] COReg
r— = The Virtual User Generat
RS T R e principle, As yvou walls th
WuGen records your acth
S A R R Y S N

Now click on the New Protocol Script and you will see the following Window. From this
window you have to choose the protocol on which the application you are going to load test
works.

VuGen provides a variety of Vuser technologies that allow you to emulate your system. Each
technology is suited to a particular architecture and results in a specific type of Vuser script. For
example, you use Web Vuser Scripts to emulate users operating Web browsers. You use FTP
Vusersto emulate an FTP session. The various V user technologies can be used alone or together,
to create effective load tests or Business Process Monitor profiles.
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SR

Mew Single Protocol Script

Cateqory : | Popular Pratocols j

’:'g; Microzoft Remaote Desktop Protocol (RDP)

Oracle [2-Tier)
W Oracle NC&

21 wieb Services

—eb [Click and Script]
Emulation of the communication between a web browser

and the web zerver at user-action level

(] Cancel

Now set the General optionsfor VuGen.
For Example To set the environment-related options:
Select Tools > General Options and click the Environment tab.

To save the current script information for auto recovery, select the Save AutoRecover
Information option and specify the time in minutes between the saves.

To set the editor font, click Select Font. The Font dialog box opens. Select the desired
font, style, and size and click OK. Note that only fixed size fonts (Courier, Lucida

Console, FixedSys, and so on) are available.

To use acomparison tool other than WDiff, select Use custom comparison tool and
then specify or browse for the desired tool.

Click OK to accept the settings and close the General Options dialog box.
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Now Set the Recording Options for recording the user actions of the application under load te<t.

g HP ¥irtual User Generator - [noname12 - Web {Click and Script)]

File Edit Wiew Insert ‘“user Actions | Tools | Window  Help

P e - | ] (@ StartRecord W F1  Performance Center Connection. .. =
- . ) =
—IStarI: Page | noname12 - Web (Click and Scr Q Quality Center Connection, .,
@ vussr_init i‘m Ly Create Controller Scenario,..
@@ Action
@@ vuzer_end | Compare with Scripk, ..
;_'.J] glabalz. h
Compare Snapshots, .,
Regenerate Scripk...
EBCDIC Translation... F7
General Opkions., .
_'P Recording Opkions. .. CKI+F? |
3
Cuskomize, ..
Compare #ML Files, .,

R ecording Options

— General: Recording

. GUI Lewel
- GUI Properties
- Advanced = " GUI-based script
- Weh Event Configuration
Network HTTP / HTHL Level
- Part Mapping
“ HTTP Properties % HTML-based script HTML Advanced... |

- Advanced

- Carrelation
" URL-bazed script WAL &dvanced... |

Advanced HTML

Script type:
HTMLE o P

x|
0K |
Chooze = % & soript describing user actions (2.0 web_link, web_submit_fam]
ashowt |8z Cancel |

& soriph containing explicit URLs only (2.0, web_url, web_submit_data)

i . . Usge Defauls
Maon HTML-generated elements (2.9, JavaScript, YES cript, Activel, Applets)

" Record within the curent script step

{” Record in separate steps and use concurent groups

" Do not record

Hint:
Move the mousze over any item to see its description.
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Now that you are ready for recording Click on the record button

HP ¥irtual User Generator - [noname12 - Web {Click a

: Ele Edit Wew Insert “user Ackions  Tools  Window  Help

:j’v|,_?v||_‘5] (| @ StartRecord | B B J1 &3 | o |5b B

Start Page | nonamel2 - Web (Click apid Sceinti |
Start recording vwour application {Ctrl+

@ vuser_init t-f._, oy

o CElny return 0
@ vuzer_end g |

;.'.J] globalz.h

Givethe Url of the application that needs to be load tested like the one below

i 2=
Application type : Ilnternet Applications LI @
Program to record IMichSth Internet Explorer LI I
UIRL Address - |http:/#127.0.0.1:10804/2bT ours! =1
“whorking directary © IEI:"-.F"ngram FilezgMercuryhLoadR unnersbin® LI I
Fecord into Action: I.&.ctinn % LI Mew. ..
v Fecord the application startup
Options. .. | Ok I Cancel I

The following table describesthe criteria for determining the business functions or
processes to beincluded whilerecording

The most frequently used transactions have the potential to
High frequency transactions impact the performance of al of the other transactions if
they are not efficient.

The more important transactions that facilitate the core
objectives of the system should be included, as failure
under load of these transactions has, by definition, the

Mission Critical transactions

greatest impact.

At least one READ ONLY transaction should be included,
Read Transactions so that performance of such transactions can be

differentiated from other more complex transactions.
Update Transactions At least one update transaction should be included so that
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performance of such transactions can be differentiated
from other transactions.

Now record the transaction in either Vuser_init or Vuser_end or action by using the recording
tool bar.

Recording... (25 events).
@ » B 11 3| Acion ~ b &l +I+ =i P

Oncetherecording isover arecording log is also generated

To view alog of the messages that were issued during recording, click the Recording Log tab.
Y ou can set the level of detail for this log in the advanced tab of the Recording options.

| |*] Replay Log || @ Facaidng Lag | B Caislation Recke | b Generation Log |

lozer § 7el:. 3d4:1] Raq;uast Ccnnection . Femote Server @ 192.168.;'
[ el 1z4r] "GET
lypzer f 7=l 1=41] I:_Sn:l 1y Cli=nt —% Server : G54 bytes (Se—l
levmexr ( Yel: lcdi] (5id. 1) Server —: Client @ 2920 bvtez |
lyzmexr [ 7el: 1cd4] (51d: 1) Server —¢ Client : 643 byhes (S
{ Jel: 1=4)] "GET #Inage?. gif’
lyzmexr [ Yel: 1z4a] (5id: 1) Client -+ Serwver : 590 byres (5=
lyzmexr [ Jel: 1od4] (51d: 1) Server —¢ Client : 2920 bykes |
l:;:l:e:l.' { Te=l: 1=4) {5ad 1) Server —: Cli=nt 2991 ]:'!;I:E: )
lvzer ( 7el: 7d81] Addres= Lockup for us update. mpa.m.un rahoo
lymer [ 7l 7d8)] Addre==s Lockup for magrib = 212 199 91 06
lpze=xr § 7el: 7d8)] Reguss=st Connection: Kenobe Sesrwesr @ BG. 0423
lvzmexr ([ Yel: 7401] Addres=s Lockurn for cig nvwebsesarch.cowm = 63 %

(= | v

Now the script will be generated for the recorded user actions and will be displayed like this

Start Page [ nonamel2 - Web (Click and Script} |
B vuser_init Action()
@ Action {

@ vuser_end =] web_url { "WsbTours"
_Q]globals.h "TRL=http: 12 7.0.0.1:1080-WehTourss"
"Resource=0"

"RecCDntentType=tExt/html .
"Refersr="

"Snapshot= tl inf"
"Mode=HTHL"

% L&ST):

lr think time({l4);

= web_ Submlt _form{" ngln pl"

Snapshot t2.inf"

ITEMDATA.

"Hame=usernamns", "Value=jojo". ENDITEHM.
"Hame=password". "Value=be=an", ENDITEHM.
"Hame=login . =", "Valu=e=47", ENDITEH.
"Hame=login. ¥". "Valus=5"., EHNDITEM.
LAST):

= web_image{'SignOff Button”,
"Alt=SignQOff Button".
"Snapshot=t3.inf",
LAST)

return 0:

¥

IE Feplay Log ||@ Recording Log ‘ Generation Log
[Hetwork Analvzer { 470: 1bc)]

[Hetwork Analyzer { 470: 1bc)] Load Hetwork Traffic Analyzers:

[Hetwork Analyzer { 470: 1bc)] Analyzer Module: WPLUS (walu==)

[Hetwork Analyzer { 470: 1bc)] Analyzer Module: WebBase (value=GetHttpProtocoldnalyzer: api_http filter dll)
[Hetwork Analyzer { 470: 1bc)] + Hetwork Analyzer: api_http filter dll @ GetHttpProtocolAnalyzer Loaded!
[Hetwork Analyzer { 470: 1bc)] + Interception Auditors: WinInetWplusInterceptiondudit:api_http_filter . dll
[Hetwork Analyzer { 470: 1bc)] Analyzer Module: WebUI (walus=)

[Hetworl Anslyzer { 470: 1bco) )] Analyzer Hodule: WebJS {(walus=)

[Hetworlk Anslyzer { 470: 1bco)) Analyzer Hodule: local_serwver (walus=)

[Hetworl Anslyzer { 470: 1bco)]
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The above oneiscalled the Script view. It can also be viewed as Tree view

Stark Page | noname12 - Web (Click and Script) ]
Action = I Page Yiew | Client Request | Server Response
H--Q Action[] Recording Snapshot

=& Uil wiebTours
-~ Think Time - 14 [sec)

; BB Submit Form: login.pl [ﬁﬁ] WebTOUrS

B8] Image: SignOf Buttan

D

Username

e
- Web Tours

e

Welcome o the Web Tours site.
To make reservations,please enter your account information to the left
If you haven't registered yet, sign up now to get access to all our resources.

Login
£ To configure the server options, use administration link.

Tree Yiew i Thurnbihails

B Feplay Log ||@ Fiecording Log | Generation Log

[Networl Analyzer ( 470: 1lbo)]

[Hetwork Analyzer ( 470: 1b=)] Load Hetwork Traffic Analyzers:

[Networlk Analyzer { 470: 1lbo)] Analyzer Hodule: WPLUS (walus=)

[Network dnalyzer { 470: 1bc)] Analyzer Module: WebBase (vwalue=GetHttpProtocolinalyzer: api_http filter dll)
[Networlk Analyzer { 470: 1lbo)] + Hetwork Analvyzer: api_http filter dll @ GetHttpProtocolAnalyzer Loaded!
[Hetwork Analyzer { 470: lbc)] + Interception Auditors: WinInetWplusInterceptiondudit:api_http filter.dll
[Networlk Anaslyzer { 470: 1bo)] Analyzer Hodule: WebUI {(walus=)

[Hetwork Analyzer { 470: lbc)] Analyzer Module: WebJS (value=)

[Hetwork Analyzer ( 470: 1bo)] Analyzer Hodule: local_server (walue=)

[Hetwork Analyzer { 470: lbc)]

The Next step is enhancethe script
This includes

1) Inserting Transaction statements
2) Log messages

3) Comments

4) Inserting Functions

5) Performing Correlation

6) Parameterize

7) Inserting Rendezvous Points

8) Doing some run time settings.

To Insert Inserting Transaction statements Log messages, Comments, Inserting Functions
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;@? HP ¥irtual User Generator - [nonamel 2 - Web {Click and Sd

! File Edit View | Insert | Yuser Ackions  Tools  Window
H - -
i [ =] = = | [§ %% MewStep... Al+Insert |y
i i —
Start Page | nonam | s~ Start Transaction... Chrl+T
& wuser_init ] End Transaction Crrl4-0
@ Action +f+ Rendezvous...
@ vuszer_end <3| Comment... =t
[#] globals.k bt
| Log Message... [~ 1T
L' n1
Y Mew Parameter... =1
< - =l
1 Toggle Breakpoint Fa =H

Now you need to perform Correlation in the script. The purpose of Correlation is

To smplify or optimize your code

For example, if you perform a series of dependent queries one after another, your code may
become very long. To reduce the size of the code, you can nest the queries, but then you lose
precision and the code becomes complex and difficult to understand. Correlating the statements
enables you to link queries without nesting.

To generate dynamic data

Many applications and Web sites identify a session by the current date and time. If you try to
replay a script, it will fail because the current time is different than the recorded time. Correlating
the data enables you to save the dynamic data and use it throughout the scenario run.

The main stepsin correlating a script are:

1 After Running the script once click on can for correlation button

P TR

File Edit Wew Insert WYuser Actions Tools ‘Window Help

G- 7~ E 0 statrecad b W 0] 1 Gl gD Tasks | St | fy e |[E]) 1 B 1 ﬂ &
Start Page | noname12 - Web (Click and Script) | g
& vuser_init | |x?c:t ioni )

::u_au Script For Correlations (Ctrl+Fa) |=

2 Determine which valueto correlate.

For most protocols, you can view the problematic statements in the Execution log. Y ou double-
click an error message and jump directly to its location. Alternatively, you can use the WDiff
utility distributed with VuGen to determine the inconsistencies within your script. For more
information, see

3 Savetheresults.
Y ou save the value of a query to avariable using the appropriate function. The correlating

functions are protocol-specific. Correlation function names usually contain the string
save param, such asweb reg save paramand Irs_save param. Refer to the specific protocol
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chapters for an explanation on how to perform correlation. In severa protocols, such as database
and Web, VuGen automatically inserts the functions into your script.

4 Reference the saved values.

Replace the constants in the query or statement with the saved variables.

Now you can Insert Parameterization Statements
Stepsfor parameterization:

Locate the argument you want to parameterize
Give the parameter aname

Select a parameter type

Define properties for the parameter type
Replace the argument with a parameter

A4 mllaaire wLaen LT Qo

web_submit_form{"login.pl".
"Snapshot=t7 . inf".

ITEMDATA,

"Hame=uzernamn=", "Valu=-jlopr& =HLITLH

"Hame=pa=szsword"., "Valus=bea «3 Undo Chrl+Z

"Hame=login.x". "Valus=47",

"Hame=login.v", "Value=G%", cut Chl

LAST) ; 5 -

of Copy ChrliC

weh _image( "SignQff Button', E

"41t=Sign0ff Button", | Baste Crl+y

"Snapszhot=t3. 1nf",

LAST) Go ko Line. .. Chrl4iG
return 0 o ko Skep in Replay Log Ckrl+E

Insert L4

T 4 Toggle Breakpoint Fa

Open Scripk Direckary

r 2.0.0 for WINZO ':' 0; HehRgp;ayE 2 Replace with alternative navigation |
acumnents and SettingssAdministra

Replace with a Parameter

| E

k]
Scan For Correlations {at Cursor) Alt+FS
ource “http:ss127 .0.0.1:1080-Weh

ource “http: o127 .0.0.1:1080-Welh Expand | Collapse b
Ak b #1270 0 1 - 1NAN ATakhTemree A4
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Onceyou click likethe above one you need to give the name for the parameter asin below
one

Eelect o Cieate Parameler

Then Select a parameter type.
Define properties for the parameter type.
Replace the argument with the parameter.

Once you do it the parameterization window will ook like this.

B jcorme I
] -

Uriqua
Each hesafion

Coniime with s veus

2

Now you can insert rendezvous point in the script

When performing load testing, you need to emulate heavy user load on your system. To
accomplish this, you synchronize Vusers to perform a task at exactly the same moment. Y ou
configure multiple Vusers to act simultaneously by creating a rendezvous point. When a Vuser
arrives at the rendezvous point, it waits until all Vusers participating in the rendezvous arrive.
When the designated number of Vusers arrive, the Vusers are released.
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To insert a rendezvous point:

1 While recording a Vuser script, click the Rendezvous button on the
Recording toolbar. The Rendezvous dialog box opens.

Fendezvous

2 Type a name for the rendezvous point in the Rendezvous Name box.

Mote: The name for the rendezvous point is not case sensitive. For example,
the Vuser recognizes Rendezvous| and rendezvous1 as the same point.

Click OK. VuGen inserts lr_rendezvous into the Vuser script. For example,
the following function defines a rendezvous point named rendezvousl:

Ir_rendezvous{"rendezvous1”);

3 To insert rendezvous points into vour script after the recording session,
select Insert > Rendezvous from the VuGen toolbar

Now you can set the run time settings
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Run-time Settings i : x|

— General: Fun Logic

- General
Fun Logic [teration Count
E:J%g B Mumber of [terations: |1 =
& Think Time -
g---.-’-‘«dditional attribubes El’ Ll N [nsert Action |
- Miscellaneous ” wuser_init

- Metwork, El Run . Irsert Block |
. Speed Simulation @ Action

- Broweser El’ e Dielete |
‘. Browezer Emulation @ wuser_end

- Intemet Pratacal Wowe Up |
i Prosy
Preferences Wiowe Do |
i Download Filkers
. ContentCheck P . |

roperties. .

Hint
towe the mouze ower any item to zee itz dezcription,

Usge Defaultz ok Cancel Help

Now we can run the script in stand alone mode to check if the scriptsare running properly

=l HP Yirtual User Generator - [noname1Z - Web {Click and Script)}]

File Edit Wiew Insert Wuser Ackions Tools Window  Help

P i) - | ez -] [ @ startRecord [B] W 11 53 | e 1sb B EP G Tasks |[FE]S

Skart P nonamel2 - Web (Click and ﬂnﬂJ_"
= agE.: I Fun (F5)
@ vuszer_init Ay )
@@ Action i
@@ vuzer_end = web_url{"WebTours".
) globalz.h "UTRL=http:~~-127 . 0.0.1:1020.~

"Resource=0",
"RecContentType=text-html".
"Refersr=".
"Shnapshot=t1 . inf".

Once the scripts are running fine in stand alone mode , these scripts can be placed in controller
for funning the load test.
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Controller

To open the Controller:

Y ou can open the Controller by choosing either of the following:
Start > Programs > LoadRunner > Applications > Controller.
Start > Programs > LoadRunner > LoadRunner. The HP LoadRunner

launcher window opens. Select the Load Testing tab, and then click Run
Load Teds.

If the New Scenario dialog box does not open on startup, yvou can open it by
choosing File = Mew or by clicking the Mew button on the Controller
toolbar.

Mew Scenario

- cakulaore
- JF Car_Rerca
A Flights2002
- A0 testi
A estz

-0 testd
-0 tests
- tasts
i

Fravali

Once the Scenario is opened we can do the following

1) Controlling the number of Virtual Users

2) Setting up the SLA

3) Define the group name, Vuser quantity, load generators, and scripts for the Vuser group
4) Add and configure one or more scripts to the Vuser group

5) Enable or disable a Vuser group for the scenario

6) Remove aVuser group from the scenario

7) Setting up the Run Duration

8) Setting up Load generators

9) Defining the run pattern by using Ramp up and ramp down
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Selecting the Scenario Type

Select one of the following scenario options

Manual Scenario. Select this method if you want to build a manual scenario. Y ou build a manual
scenario by creating groups and specifying the script, the load generator, and the number of
Vusers included in each group.

Use the Percentage Mode to distribute the Vusers among the scripts. Select this option if you
want to build a manual scenario by specifying a number of Vusers to be distributed among the
selected Vuser scripts.

Goal Oriented Scenario. Select this method to have LoadRunner build a scenario for you. In a
goal-oriented scenario, you define the goals you want your test to achieve, and LoadRunner
automatically builds a scenario for you, based on these goals.

To create Vuser Groups:

1 On the Scenario Groups pane toolbar, click the Add Group button. The Add
Group dialog box opens:

“.Q' imode
i h:sl
s

2 In the Group Mame box, enter a name for the Vuser group.

3 From the Vuser CQuantity box, select the number of Vusers that vou want to
create in the group.
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Creating Load Generators

Select a load generator from the Load Generator Name list. To use a load
generator that does not appear, select Add from the Load Generator Name
list. The Add New Load Generator dialog box opens:

Al Mot Load Gemsialon

R E— L
Flalicim [tidona =l Cancel
Tenporany diecion: | Help

¥ Erchiz lnnd generskar ba fake part i the sceradn paie =

Type the name of the load generator in the Name box. In the Platform box,
select the type of platform on which the load generator is running.

Defining SLA:

An SLA is a formally negotiated agreement between two parties. It is a contract that exists
between customers and their service provider, client or between service providers. It records the
common understanding about services, priorities, responsibilities, guarantee, and such —
collectively, the level of service. For example, it may specify the levels of availability,
serviceability, performance, operation, or other attributes of the service like hilling and even
penalties in the case of violation of the SLA.

About Defining Service Level Agreements

When you design a load test scenario, you can define goals or service level agreements (SLAS)
for the performance metrics. When you run the scenario, LoadRunner gathers and stores
performance-related data. When you analyze the run, Analysis compares this data against the
SLAsand determines SLA statuses for the defined measurements.

Depending on the measurements that you are evaluating, LoadRunner
Determines SLA statuses in one of the following ways.

SLA status determined per time interva within the run. Anaysis displays SLA statuses at et
time intervals—for example, every 10 seconds—over atimeline within the run.

SLA status determined over the whole run. Analysis displays a single SLA status for the whole
scenario run.
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To define an 5LA for Average Transaction Response Time:
Open the Service Level Agreement Wizard.

» If you are working in Analysis: Select Tools = Configure SLA Rules to open
the Service Level Agreement dialog box. Click Mew.

»= If you are working in the Controller: In the Design tab, in the Service
Level Agreement pane, click New.

The Service Level Agreement wizard opens.

Complete the SLA Wizard steps, as described in the following sections.

Measurement—S3Select a Measurement for Your Goal
For Average Transaction Response Time, LoadRunner evaluates SLA statuses
at set time intervals within the run.

Under SLA status determined per time interval within the run, select
Average Transaction Response Time.

Transactions—3Select Transactions

From the Awvailable Transactions list, select the transactions that vou want to
evaluate as part of vour SLA and click Add.

Mote: You can select multiple fransactions using the CTRL key.

The transactions you selected are displaved in the Selected Transactions list.

Load Criteria—5et Load Criteria

Select load criteria for vour goal and define appropriate load value ranges.

|27 service Level £ ! 3 n x|

D ]
LoadRunnek

Service Level

Service Level Agreement - Goal Definition

Select a Measurement for Your Goal
Select a measurement from one of the categories below,

Mate: Load criteria can be defined only when selecting meazurements whose SLA statuzes are
determined at time intervals over a timeline.

©° SLA status determined at time intervals over a timeline

Agresment " Average Transaction Besponse Time [per time interval)

® Siart

¢~ Emors per Second [per time intersal]

£ SLA status determined over the whole un

® Tronsaction

® Load riteria

" Total Hits per run

= Awverage Hits (hits/sec) per run

® Thresholds

® Finish

= Total Throughput [bptes] per min

= Awverage Throughput [bytes/zec] per rn

< Back Mewt > | Cancel Help
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» In the Load Criteria box, select the relevant load criteria that yvou want to
use—for example, Running Vusers.

To define an SLA without load criteria, select None in the Load Criteria box.

» In the Less than box, set the lower load value range by entering a maximum
value for this range. This range is between 0 and the maximum value you
entered, but does not include the maximum value.

» To set in-between load value ranges, select Between from the Greater than
or equal to/Between combo box and enter minimum and maximum values
for the range. The minimum walue is included in the range and the
maximum value is not.

Funning Yucers

Mote: You can set up to three in-between ranges.

» To set the upper load value range, select Greater than or equal to from the
Greater than or equal to/Between combo box and enter the minimum
value for this range. The minimum value is included in this range.

Mote: Valid load value ranges are consecutive—there are no gaps in the
range—and span all values from zero to infinity.

Running the Scenario
The following procedure outlines how to run a scenario:
Open an existing scenario or create anew one.
Configure and schedul e the scenario.

Set the results directory.
Run and monitor the scenario.
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P LoadRunner Controller - Scenariol - [Run] SH i e T _l=l <
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Graph Analysis:

During load test scenario execution, Vusers generate result data as they perform ther
transactions. The Analysis graphs help you determine system performance and provide
information about transactions and Vusers. You can compare multiple graphs by combining
results from several load test scenarios or merging severa graphsinto one.

The Report utilities enable you to view a Summary HTML report for each graph or a variety of
Performance and Activity reports. Y ou can create areport as a Microsoft Word document, which
automatically summarizes and displays the test’ s significant data in graphical and tabular format.

Analysisgraphsaredivided into the following categories.

Vuser Graphs. Provide information about Vuser states and other Vuser datistics. Error
Graphs. Provide information about the errors that occurred during the load test scenario.
Transaction Graphs. Provide information about transaction performance and

response time.

Web Resource Graphs: Provide information about the throughput, hits per second,
HTTP responses per second, number of retries per second, and downloaded pages per
second for Web Vusers.

Web Page Diagnostics Graphs: Provide information about the size and download time
of each Web page component.

System Resour ce Graphs: Provide statistics relating to the system resources that were
monitored during the load test scenario using the online monitor.

Starting Analysis

You can open Anaysis as an independent application or directly from the Controller. To
open Analysis as an independent application, choose one of the following:

Start > Programs > LoadRunner > Applications > Analysis

Start > Programs > LoadRunner > LoadRunner, select the Load Testing tab, and then
click Analyze Load Teds.

Once you start the Session a Summary report will be displayed
Summary Report:

The Summary report provides general information about load test scenario execution. This report
is always available from the Session Explorer or as atab in the Analysis window. The Summary
report lists statistics about the scenario run and provides links

to the following graphs. Running Vusers, Throughput, Hits Per Second, HT TP Responses per
Second, Transaction Summary, and Average Transaction Response Time. The appearance of the
Summary report and the information displayed will vary depending on whether an SLA (Service
Level Agreement) was defined. An SLA defines goals for the scenario. LoadRunner measures
these goals during the scenario run and analyzes them in the Summary report.
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This Summary Report will have the following details:

Transaction Summary

This section displays a table containing the load test scenario’s diagnostics data. Included in this
data is a percentile column (x Percent). This column indicates the maximum response time for
that percentage of transactions performed during the run. For example, in the table below, the
value in the 88 Percent column for browse special books is 8.072. This means that the response
time for 88% of the browse special books transactions was less those 8.072 seconds.

Transaction Summary

Transaclions; Total Passed: 34,343 Total Failed: 131 Total Stopped: 0 Bverage Fesponse Time

Trancaction Mane SLA Status Minimun Owverage Maxinnum Std. Deviatoen #E Percent Pass Fal Stop

brovwse spadal boaks "l 1.07B 2,948 113.754 7,372 2,072 16,673 & ]
cradit card walidstion " 0.485 2.=08 14.062 3.453 F.E232 14,949 0O 1]
load main page " ol 3.525 31.021 117,625 Z0.F3z 54,133 S24 125 0

Scenario Behavior over Time

This section displays the average errors per second received by the application under test per
time interval. For example, O means that on average there were zero errors received per second
for that time interval, 0+ means that on average there were dlightly more than zero errors
received, and so on.

Scenano behaviour aver time

Transaction: | dogbart = | Tirma ramge to dell down Fromm IUE":'ﬂJU wan ill Tat IIJI:II:HIJL f ] ﬁ

Transann HName Tirne Ranges

ALT Errors 0 | o

e e e e e e e e

e e e e e e e e e e e

doghst
e L L |
oo+ D T D

(=1 = (=1 (=1 (=1 (=1 =] (=1 = (=1 (=1 [=] (=1
2 2 =2 o 92 =8 5§ 2 2 2 o O &
L= b= (=1 (=1 (=1 L= =] (= b= (=1 (=1 [=] L=
e =~ N - - - -
(=] - (o] b (= = L e b= = (&) I (=]
L= oA =1 o = o [=] L] L= o =] (5} L=

Analyze Transacon

HTTP Responses Summary

This section shows the number of HT TP status codes returned from the Web server during the
load test scenario, grouped by status code.
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X Worst Transaction

The X Worst Transactionstable shows the worst transactions in terms of how often the transactions
exceeded the SLA boundary during the run, and by how much.

50

orsttransacions

Transschon Mame

Faillure Eatio]<o]

[excecded time ‘bonsaction duration)

Faillure ¥alus[oo]
[response e,/ LAY

doghert

44,15

4,14

linwa [ndemeal

firg oxcoading ratio

Mawx axceeding rato

00 :00;:30-00;01: 00
00:01,10-00,01: 25
o0l i 5-00:01: 50
00 0215-00:02: 20

4,23
1.49%
261
£.9

7,33
224
2,51
B.47

Snalyza Tramsadion

SLA Report

An SLA (Service Level Agreement) defines goals for the load test scenario. LoadRunner
measures these goals during the scenario run and analyzes them in the Summary report. The SLA
Report shows the succeeded or failed status of al SLAs that were defined for the scenario run.

The Following are the other Graphs that are Displayed

Transaction Response Time under Load

Displays average transaction response times relative to the number of Vusers running at
any given point during the load test. This graph helps you view the general impact of
Vuser load on performance time and is most useful when analyzing a load tes which is
run with a gradual load.

Transaction Response Time Under Load
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Hits Per Second Graph
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Displays the number of hits made on the Web server by Vusers during each second of the

load tegt. This graph helps you evaluate the amount of load Vusers generate, in terms of
the number of hits.
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Running Vusers Graph

Displays the number of Vusers that executed VVuser scripts, and their status, during each
second of a load test. This graph is useful for determining the Vuser load on your server
at any given moment.

Running Yusers
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Average Transaction Response Time

Displays the average time taken to perform transactions during each second of the load
test. This graph helps you determine whether the performance of the server is within
acceptable minimum and maximum transaction performance time ranges defined for your
system.

Average Transaction Response Time
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Hits per Second

Displays the number of hits made on the Web server by Vusers during each second of the
load tegt. This graph helps you evaluate the amount of load Vusers generate, in terms of

the number of hits.

Hits per Second
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Throughput

Displays the amount of throughput (in bytes) on the Web server during the load ted.
Throughput represents the amount of data that the Vusers received from the server at any
given second. This graph helps you to evaluate the amount of load Vusers generate, in

terms of server throughput.

Throughput
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Transaction Summary

Displays the number of transactions that passed, failed, stopped, or ended with errors.

Transaction Summary

Murnber of Transactions

Action_Transaction wiger_end_Tranzsaction wuser_init_Transaction

Average Transaction Response Time

Displays the average time taken to perform transactions during each second of the load
test. This graph helps you determine whether the performance of the server is within
acceptable minimum and maximum transaction performance time ranges defined for your
system.

Average Transaction Response Time
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Page Component Breakdown

Displays the average download time (in seconds) for each Web page and its components.

S0.36 % of 4 631

Windows Resour ces
Displays a summary of the System Resources usage for each Windows based host.

Page Component Breakdown
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Connections Per Second

Displays the number of Connections per Second
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Downloaded Component Size (KB)

Displays the size of each Web page component. Note that the size displayed includes
both the size of the component and its header

Downloaded Component Size {KB)
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Timeto First Buffer Breakdown

Displays each Web page component’s relative server/network time (in seconds) for the
period of time until the first buffer is successfully received back from the Web server.

Time to First Buffer Breakdown
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